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Introduction: UiPath Analytics Data Flows 
 

 

 

This document describes the Reporting and Analytics for Orchestrator from the data, data flows and 

implementation points of view, and provides a step-by-step set of instructions to deploy the described 

functionality using your existing Tableau environment. 

 

Why reporting and analytics using off-the-shelf BI (Business Intelligence) tools? 

➢ Take advantage of and leveraging existing BI/Analytics architecture and knowledge 

➢ Easily blend RPA data with external data 

➢ Handle large volumes of data (weeks-months) with minimal impact on Orchestrator functionality 

➢ Leverage high-performance data engine and user-friendly building tools 

➢ Lightweight: easy to implement and customize 

  



Data Source and standard connection 
 

The primary data source is Orchestrator’s SQL Server database, specifically the operational tables used for 

managing the Jobs and Queue Items, among others.  

Since the Orchestrator DB schema changes potentially for every update, external BI systems can get the data from 

a SQL Server Views that abstract the UiPath data model and provides a standardized data pipeline for the BI 

reporting tools. These Views are implemented in the database after every Orchestrator update, by running a 

specific SQL script (provided after each upgrade). 

The advantage of using this setup is that it hides the database schema complexity and changes, and exposes a 

standard, documented data model and set of KPIs. 

 

Data Flows and Refresh 
 

Once the Views are saved in the SQL Server database, the data can be easily extracted and added to existing 

systems. To minimize the load on the Orchestrator Database, it is extremely important that the same data is 

queried as few times as possible (ideally only once), which is possible by using the Incremental Refresh method. 

This method uses a timestamp field containing the last time a record was modified, and only retrieves the records 

that have changed since the last time the database was queried. 

There are several options for the data flow setup: 

1. Direct connection (SQL Server → Tableau), using Tableau Extracts and Tableau’s Incremental Refresh 

functionality 

2. Use a secondary Operational Data Store (SQL Server → ODS → Tableau). In this case, you will need to 

manage the Incremental Refresh for the first step to avoid overloading Orchestrator. 

NOTE: You can also use flat or Excel files extracts as data sources if none of the options above is feasible, 

however try to limit the number of rows queried and to run the query during a time when Orchestrator is not 

heavily used. In all cases, the system should use the Views described in the previous section. 

The direct connection setup has been built and tested to minimize the load on the SQL Server database, which 

has not been designed as a reporting database. Ideally, the Tableau data engine should connect to a "mirror 

DB" as described here:  https://docs.microsoft.com/en-us/sql/database-engine/availability-

groups/windows/overview-of-always-on-availability-groups-sql-server?view=sql-server-2017 , especially if you 

have a high volume of transactions on the database. This setup takes advantage of the high-performance 

Tableau Data Engine by using data extracts and querying every piece of information only once (by using 

incremental refresh), while maintaining enough history for meaningful analysis. Configuring the Tableau 

extracts and refresh schedules as described in the step-by-step instructions is critical for optimal functionality 

and avoiding Orchestrator problems. 

 

  

https://docs.microsoft.com/en-us/sql/database-engine/availability-groups/windows/overview-of-always-on-availability-groups-sql-server?view=sql-server-2017
https://docs.microsoft.com/en-us/sql/database-engine/availability-groups/windows/overview-of-always-on-availability-groups-sql-server?view=sql-server-2017


Incremental Refresh details – please read 
The timestamp field used for Incremental Refresh is called “Last Modification Time” in Tableau 

(lastModificationTime in the SQL Server views). When you set the Incremental Refresh in Tableau, you have the 

option to pick the timestamp field for it. If you select the option of using an Operational Data Store as an 

intermediate step, you need to set up your ETL process to do something similar, to minimize the queries on the 

Orchestrator database. 

Incremental Refreshes in Tableau in conjunction with the “Extract” option for the data source (rather than the 

“Live” option). Setting up the “Live” connection in Tableau for a data source will bring all data every time the user 

refreshes the report, which could potentially cause Orchestrator problems.  

More details here: https://onlinehelp.tableau.com/current/pro/desktop/en-us/extracting_refresh.htm 

 

Duplicate jobs / queue items created by Incremental Refreshes 
 Since all records that have changed since the last refresh are added to the Tableau extract, it is very likely that 

older versions of some records will appear in the extract. For example, a job will appear as Pending, then 

potentially as Running, finally as Successful or Failed. Only the most recent record for the job should be used for 

report, so all default Tableau visualizations have a filter on a calculated binary field “Last_Rec” that flags those 

records and eliminates from the report older versions of the same job (or Queue Item). 

Please check that every Jobs and Queue Items visualization has the “Last_Rec” filter enabled and set to True. 

 

Incremental Refreshes and Full Refreshes 
We suggest setting up the Incremental Refresh frequency to hourly or half-hourly for normal reporting and 

analytics utilization. A full refresh can be scheduled weekly (during low load periods like week-end nights) or every 

2 weeks. 

 

Using Tableau as a monitoring tool 
We do not encourage using the above described setup for short-term monitoring of jobs. Using incremental refresh 

and extracts, you can set up Tableau refreshes as often as every few minutes (using the tabcmd utility), however we 

cannot guarantee the stability of the system. 

 

  

https://onlinehelp.tableau.com/current/pro/desktop/en-us/extracting_refresh.htm


Step-by-step Tableau Dashboards setup 
 

Contents of the UiPath Tableau Dashboards package: 
1. SQL script for adding Views to the SQL Server database 

2. Tableau default dashboards 

3. Excel file containing the mock data (current data sources for the provided dashboards) 

4. Documentation  

 

Instructions: 

 

Step 1: Create View in SQL Server 

Use the SQL code in script file to create the views. Please make sure you are using the script version corresponding 
to your Orchestrator version. 

 

Then, for each of the dashboards you want to import, follow the next steps: 

 

Step 2: Import and save the pre-packaged dashboards, as well as the Excel file containing the dummy 

source data: 

Download the necessary dashboard(s) from the link/repository provided and save them to your computer. Do the 
same for the dummy data Excel file that you will be prompted to point to when you open the dashboards' data 
source. Save the Excel file on your computer and point to it whenever Tableau asks for the original data source 
location. You will only need it until you switch to the SQL Server data source. 

 

  



Step 3: Open the Tableau file and create in it a new data source: 

 You will need Tableau Desktop installed on your computer. Double-click on the Tableau file to open it. 

- Click on any of the dashboard tabs; the charts that are displayed contain dummy data that will need to 

be replaced. 

- In the Data menu at the top left select "New Data Source" 
- Select Microsoft SQL Server from the list 
- Insert the server name, database name and the authentication information in the connection window 

then click Sign In. If the information is correct and you have access to the database, you should get an 
empty table with the database name at the top. 

- From the tables/views list on the left, click and drag the view with the required name (for ex. 
Jobs_BI_View) into the blank area at the top of the page: 

 

 

 

  



Step 4: Set up the Refresh configuration of the new data source: 
To minimize the load on the database and to use the power and speed of the Tableau data engine, we need to 

store the queried data into Tableau extracts. Also, these extracts must be set up for Incremental Refresh, which 

means that only the rows that have been modified since the last query are retrieved from the database. 

- At the top right of the page, set the Connection setting to Extract then click Edit to open the Edit dialog 

- Set the Number of Rows setting to All Rows 

- Check the "Incremental Refresh" box and set the identifying column name to "Last Modification Time". 

Then click OK to close the dialog box. 

 

NOTES: 

- If you need to bring more than one data source into a dashboard, you need to perform steps 3 and 4 
completely for each new data source you are creating. Bringing more than one view at a time as 
explained in the last part of step 3 will create unwanted joins 

- Although the refresh is incremental, the first one will bring the full data set, and should be done during 
a low activity period. Also, consider querying only part of the data (the most recent x months) using 
filters. 

  



Step 5: Switch the data source of the Tableau file with the newly created one: 
Select any visualization tab (not a dashboard one) by clicking on a visualization in the dashboard, then clicking on 

the "Go to Sheet" button at the top left (or right). This should open the hidden visualization. 

 

In the top menu of the newly displayed visualization, click on the "Data" item and click on "Replace Data Source". 

The Replace Data Source should appear: 

 

- In the Replacement field, select the new data source you have just created then click OK 

- Go back to any Dashboard tab and check that the visualizations look OK. 

NOTE: While switching the data source, some of the legends and colors might get reset; this is a known Tableau 

issue. You will need to adjust those manually. 

 

  



Step 6: Delete the references to the original dummy data file: 
Go to the Data Source tab of Tableau (left hand side).  

In the upper part of the Tableau window, select the original data source the one you have replaced by the SQL 

Server view and select it. (FYI: for Jobs you will see JobsDB and for Queues you will see QueueDB) 

 

Then, in the "Data" menu, click on "Close Data Source". 

 

Alternatively you can right click the old data source and click the “close” option (which will remove the link from 

the dashboard to the old data source). 

 



Step 7: Save the new Tableau Dashboard: 
In the File menu, click on Save As and give the file a meaningful name. In the lower part of the window, select the 

file type .twbx (which already contains the data in it) and click OK. 

 

Step 8: Publishing the Extract and the Dashboard: 
Once you have connected the dashboard to your SQL Server, you need to deploy it from Tableau Desktop to 

Tableau Server. You will find information about this topic on the Tableau website, however here are a few hints: 

- It is much better to export the extract separately to Tableau Server, then the dashboard (this will 

automatically set the data source for the local file to the extract on the Tableau Server). Have all 

analysts work on the extract. The alternative, exporting the packaged bundle (Tableau file + Extract) 

risks to duplicate the extracts and overload the database. This will ensure only one extract is querying 

the database, regardless of how many Tableau analysts are using the data. 

- Set up a suitable refresh schedule for the extract. Incremental refreshes every 15 minutes (or even 

every hour) should work fine. You can also schedule full refreshes during week-ends etc. 

Note: Process has to be repeated for both the Jobs and Queues dashboards, in order to have the 2 dashboards 

connected to your Orchestrator database as data source. 

 

 

Data Dictionary for Jobs and Queues data sets 
 

In the below tables the datasets that are contained in the specific views created in the database are described. The 

fields in black are native and are extracted directly from the Orchestrator database and the blue fields are derived 

fields calculated through the views definitions, mostly KPIs that are tracked in the dashboards. 

Jobs 

Field Name Description 

Job Id DB primary key of the job 

Job Key Unique key for job, can be used for joining with external data 

Job Start Timestamp of the start of the job, in Orchestrator local time 

Job End Timestamp of the end of the job, in Orchestrator local time 

Query Time Timestamp of the time the SQL Server query was actually ran (for all practical 
purposes, this should be considered the report time) 

Job State Any of the following: 'Pending', 'Running', 'Canceling', 'Terminating', 'Failed', 
'Successful', 'Canceled'  

Job Trigger Manual' or 'Scheduled' 

Job Info Free Text field, used for finished jobs to add more information about the 
outcome (especially non-successful situations) 

Job Created Timestamp of the moment the job was created in the database 

Last Modification Time Timestamp of the most recent time the job record has been changed. This is 
used for incremental refresh purposes, to avoid duplicates 

Org Unit Id Id of the organization unit the job belongs to 

Release Id DB primary key of the release of the process being ran 



Process Name Name of the Process. More than one release can share the same Process 
Name 

Unattended Flag Binary flag for Attended /  Unattended robots 

Robot Id DB primary key of the robot which ran the job 

Robot Name User-given name for robot. Can have duplicates (more than one Robot Id for 
one Robot Name) 

Machine Name Identifier for the computer on which the job was run 

User Name Identifier for the Windows User for which the job was run 

Robot Type Identifier for the computer on which the job was run 

Tenant Name Name of the Orchestrator tenant in which the job has been (or will be) 
executed 

Environment Name Name of the environment in which the job has been (or will be) executed 

StDev_Dur_ProcHrs Aggregate: Standard deviation of the job duration, computed separately for 
each Process Name (will aggregate all releases that share the same Process 
Name) 

Avg_Dur_PendingHrs Aggregate:  Average of the "pending time" for jobs, computed separately for 
each Process Name (will aggregate all releases that share the same Process 
Name). Time in pending = Job Start - Job Created 

FinishedExec Binary flag marking whether a job has finished execution 

Duration Outlier Equal to 1 if the duration of a job  is more than 2 standard deviations above 
the average duration for that specific Process Name. In this situation, the 
duration of the job is equal to JobDurDaysGantt (includes jobs that were still 
running at time of the query, see definition below). Is used to flag jobs that 
might be "frozen" or waiting for an input from the user. Otherwise, it is NULL. 

Last_Rec Binary flag marking whether a certain record is the most recent in the 
database, for each specific jobs. Due to the incremental refresh mechanism, 
the data set might have more than one record for each job, and only the most 
recent one must be used for reporting. All visualizations MUST have this field 
as a filter, otherwise the same job might be counted multiple times. 

Gantt Filter Binary flag marking all the jobs that have started within 24 hours of the query 
time. Used for the jobs Gantt Chart 

is_successful Binary flag marking whether a job has successfully finished execution 

successful% Aggregate: percentage of successful jobs out of all finished jobs 

Avg Process Duration (h) Aggregate: Average  job duration, computed separately for each Process 
Name (will aggregate all releases that share the same Process Name) 

JobPendingHrs Time (in hours) between the moment the job was created and when it 
actually started 

JobDurDaysGantt For finished jobs, the difference between the start and the end of the job. For 
currently running jobs, the difference between the start of the job and the 
query time. Unit = days 

Job Duration (h) For finished jobs, the difference between the start and the end of the job. For 
currently running jobs, the difference between the start of the job and the 
query time. Unit = hours 

Hours_Robot_Day Aggregate: for each robot and for each day, the total duration in hours of all 
jobs that started during that day 

Job State2 Duplicate of the Job State field, needed for technical reasons :) 

Max Query Time Equal to the time the DB query was run last time 

 

 



Queues 

Field Name Description 

Queue Name Name of the queue 

Queue Id DB primary key of the queue 

Tenant Name Name of the Orchestrator tenant in which the job has been (or will be) executed 

Robot Name User-given name for robot. Can have duplicates (more than one Robot Id for one 
Robot Name) 

Robot Id DB primary key of the robot which processed the queue item 

Machine Name Identifier for the computer on which the job was run 

User Name Identifier for the Windows User for which the job was run 

Org Unit Id Id of the organization unit the queue item belongs to 

Item Id DB primary key of the queue item 

Transaction Key External unique identifier for the transaction (One transaction is the action of 
processing a queue item) 

Item Priority Identifier for the computer on which the job was run 

Transaction Status One of the following values: 'New', 'InProgress', 'Failed', 'Successful', 'Abandoned', 
'Retried', 'Deleted'. Please see the Orchestrator documentation at: 
https://orchestrator.uipath.com/docs/queue-item-statuses#section-revision-statuses 

Review Status Also called "Revision Status". One of the following values: 'None', 'In Review', 
'Verified', 'Retried'. 
Please see the Orchestrator documentation at: 
https://orchestrator.uipath.com/docs/queue-item-statuses#section-revision-statuses 

Transaction Start Timestamp of the moment the item has started being processed 

Transaction End Timestamp of the moment the item has ended being processed 

Query Time Timestamp of the time the SQL Server query was actually ran (for all practical 
purposes, this should be considered the report time) 

Last Modification Time Timestamp of the most recent time the job record has been changed. This is used for 
incremental refresh purposes, to avoid duplicates 

Retry Number Number of times an item has been attempted before the current one (failed attempts) 

Seconds Prev Attempts Number of seconds the item has spent in the previous failed attempts 

Item Created Time the item has been created 

Item Data Specific queue item data 

Deferred Date The queue item should NOT be processed prior to this date 

Item Reference External reference for the queue item 

Has Due Date Flag Binary flag marking whether there is a due date for the item 

Due Date Date before which the queue item must be processed (for SLA purposes, for example) 

Transaction Output Data output of the processing of the queue item 

Exception Type Can be Null (equivalent to Successful), Business Exception and Application Exception 

Exception Reason Explanation regarding the cause of the exception 

Exception Details Additional details regarding the cause of the exception 

Exception Time Timestamp of the moment the exception occurred 

Exc. Type Equal to Exception Type, however has the value 'Successful' for transactions that have 
no exceptions 

TransactionDurSec Duration of the transaction, in seconds 

FinishedExec Binary flag marking that the item has been processed 

StartedExec Binary flag marking that the item has started being processed 

First Pass Yield Aggregate: Ratio of items that were successful on the first attempt to the items that 
were successful overall 



Required Robot Hours Aggregate: Total number of robot-hours necessary to finish all queue items in each 
queue, using the average duration per queue item (Avg Duration(min)). Computed 
separately by queue name 

Trans. Status Duplicate of the Transaction Status field, with slightly different wording 

SLA Status Broke SLA' if the item was finalized after its due date, or if it has not been processed 
and the due date has passed; 
'In SLA' if the item was finalized before its due date or if the due date has not yet 
passed 
'No SLA' if the item has no due date, 
'Deferred' if the item has a deferred date which is in the future compared to the query 
time 

Max Query Time Equal to the time the DB query was run last time 

LastRec Binary flag marking whether a certain record is the most recent in the database, for 
each specific jobs. Due to the incremental refresh mechanism, the data set might have 
more than one record for each job, and only the most recent one must be used for 
reporting. All visualizations MUST have this field as a filter, otherwise the same job 
might be counted multiple times. 

Avg Duration (min) Aggregate: average duration of all successful transactions, computed per queue name, 
in minutes 

Has Due Date Binary flag marking whether the queue item has a due date 

Final Failure Rate Percentage of items that have failed after all available retries 

Has Deferred Date Binary flag marking whether the item has a deferred date 

Required Robots Aggregate: per queue name, the rounded up number of robots required to finish the 
items currently in queue 

Item in Queue (min) Time between the moment the item has been created and the moment the processing 
starts 

 


